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INTRODUCTION 
 
 
The Event Recorder System is a tool for logging and displaying changes in digital conditions 
within a PLC program. It consists of 3 software applications: 
 

• Event Collector – Captures events 
• Event Logger – Logs events to a PC database 
• Event Viewer – Displays logged events 

  
A typical Event Recorder System is shown in the following figure: 
 

 
 
The Event Viewer is a Windows based PC application that is used to display the stored event 
data. It is very user friendly with the following features: 
 

• Events are displayed in a “spreadsheet” format. 
• Events are displayed for a specified date/time period.  
• All events within the specified date\time period can be displayed or just specific events. 
• Event groups can be created in order to only display events that share some commonality. 
• Colors can be assigned to events. 
• The total number of occurrences of events can be displayed. 
• Displayed data can also be printed. 

 
This manual describes how to install the Event Viewer program onto a Windows computer and 
then how to use the features listed above. 
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INSTALLING EVENT VIEWER 
 
The Event Viewer can be installed on the same PC as the Event Logger or on any other PC that is 
networked to the Event Logger event databases. The Event Viewer is provided in the “Event 
Viewer” folder on the “Event Recorder System” USB flash drive.  
 
The program is automatically installed by double-clicking the “Setup.exe” file in the “Event 
Viewer” folder. At that time an installation wizard is launched. The wizard will display a default 
folder in which to install Event Viewer on the PC. This default folder is:  
 

c:\Program Files (x86)\Brigger And Associates\Event Viewer . 
 
Another folder can be specified if desired. Once the folder has been specified, the destination 
folder will be created, if it does not already exist, and Event Viewer will be installed and a 
shortcut to the program, with the following icon, will be added to the desktop. 
 

 
 
Once the Event Viewer has been installed, it is recommended that Windows Update be checked 
for any critical changes to the “.NET Framework”. 
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STARTING AND STOPPING THE EVENT VIEWER 
 
The Event Viewer program is started by double-clicking the “Event Viewer” shortcut on the 
desktop,  
 

 
 
The program can also be started by selecting “Event Recorder System\Event Viewer” from the 
Windows  “Start” menu. When the Event Viewer is started, the Event Viewer window is 
displayed. This window is described below. 
 
The Event Viewer is stopped by clicking the “File” pull-down menu of the Event Viewer window 
and then clicking “Exit”. It is also stopped by clicking the window close button in the upper 
right-hand corner. 
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SPECIFYING PLC DATABASE LOCATIONS 
 
Each PLC has an associated Microsoft Access database file (.mdb). This database is created 
when the Event Logger is configured. It has all the collected event data for the PLC. It also has 
the PLC name and the configurations for colors, groups, and totals used by Event Viewer 
(described below). The PLC name is assigned when the Event Logger is configured. 
 
The location of the PLC database file is specified in the PLC Database Location sub-window: 
 

 
 
This sub-window is displayed automatically when the Event Viewer is started for the first time 
following installation. Thereafter, it is accessed from the Event Viewer window by clicking the 
“Setup” pull-down menu and then clicking “PLC Database Location”.  
 
The Event Logger can collect data from multiple PLC’s that collect event data using the Event 
Collector  PLC logic. For each PLC there will be a separate database file. The Event Viewer 
displays the data for a single PLC. However, for those situations in which data is collected for 
several PLC’s the database path for each PLC can be specified in the PLC Database Location 
sub-window. This makes it easier to select a PLC for display, as explained below. 
 
For each PLC, the directory path to the PLC database file is entered in the “Database path” entry 
box followed by clicking the ADD button. The file name must include the complete path to the 
file. The file name and path can be entered directly in the entry box or it can be selected from the 
Locate Database window which is displayed by clicking the ellipsis button next to the entry box. 
When the ADD button is clicked the database file is added to the “PLC Selection” box. The file 
name is preceded by the assigned name of the PLC. PLC’s can be removed from the list by 
selecting the PLC in the list and clicking the REMOVE button. 
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The order that the PLC database files are listed in the PLC Database Location window is the 
same order that the associated PLC’s are listed in the PLC Selection window (see below). This 
order can be changed by selecting the file and using the up and down arrows to change its 
location in the list.  
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SELECTING THE PLC 
 
The PLC whose events are to be displayed is selected from the PLC Selection sub-window: 
 

 
 
This sub-window is displayed automatically after the PLC’s are initially specified in the PLC 
Database Location sub-window. Thereafter, it is accessed from the Event Viewer window by 
clicking the “Display” pull-down menu and then clicking “PLC Selection”.  
 
This sub-window displays the name of each PLC listed in the PLC Database Location sub-
window. A PLC is selected by clicking the check box next to the PLC name and then clicking 
the ACCEPT button.  
 
The Event Viewer can display events of multiple PLC’s, although only the events for a particular 
PLC can be displayed at one time. Therefore, only one PLC can be selected at a time. Note that 
the order that the PLC’s are listed is the same as the order the PLC database paths are listed on 
the PLC Database Location window. 
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EVENT VIEWER WINDOW 
 
The events are displayed on the Event Viewer window. This is the main window of the Event 
Viewer. All other windows will be displayed over this. 
 

 
 
This window not only displays the event data but also has menu selections for selecting other 
features of the Event Viewer. At the bottom of the window are buttons for searching for events or 
for displaying previous or next occurrences of the selected event. 
 
As shown, the following is displayed for each event: 
 
Time 
This is the PLC calendar date and time when the event was captured. 
 
Event Number 
This is the assigned event number for the event. Each event is assigned an event number when 
the event was first configured in the PLC (see Event Collector manual).  
 
State 
“ON” is displayed if the event digital condition went from off (false or 0) to on (true or 1). 
“OFF” is displayed if the condition went from on to off. 
 
Description 
This is an assigned description of the event. Event descriptions are described in the “Event 
Descriptions” section below. 
 
Address 
This is the assigned address of the monitored digital condition. These are entered when the event 
descriptions are entered.  
 
 
The events that are displayed are those events that meet the search criteria specified on the 
Parameters window, described below. 
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FINDING AN EVENT 
 
At the bottom of the Event Viewer window are buttons for searching for events or for displaying 
previous or next occurrences of the selected event: 
 
 

 
 
An event is highlighted by clicking anywhere in the event data row. The last occurrence of that 
event is displayed by clicking on the “Find Previous…” button. Likewise, the next occurrence is 
displayed by clicking on the “Find Next …” button. 
 
A particular event is found by clicking on the “Find”  button which displays the following sub-
window: 
 

 
 
An event can be found by either specifying the event number or by text within the event 
description. To search for event number, the “Event” box is clicked and the number entered in 
the “Criteria” box. To search by description, the “Description” box is clicked and the text to 
search for in each event description is entered in the “Criteria” box. 
 
By clicking on the “From Beginning” box, all the events displayed are searched. If the “Prior to 
Selection” is clicked, the search starts at the beginning of the displayed events up to the currently 
selected event. Likewise, if the “After Selection” box is clicked, the search starts at the currently 
selected event and goes to the end of the displayed events. 
 
The search is carried out when the FIND button is clicked. When an event is found it is 
highlighted. 
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EVENT DESCRIPTIONS  

 
When events of a PLC are logged to its event database by Event Logger, the events are identified 
by the event number. In order to be able to better read the event data, the Event Viewer allows 
the following to be associated with each event number: 
 
• Event Description 
• Monitored PLC address bit 
 
By default, the event description of each event is the event number and the PLC bit address is 
“Undefined”. These can be edited in the Event Descriptions window. This window is displayed 
from the Event Viewer window by clicking the “Setup” pull-down menu and then clicking 
“Event Descriptions”. 
 
The Event Descriptions window has 4 columns: 
 
• Event  
• Description 
• Address 
• New Event bit. 
 

 
 
As described in the Event Collector manual, each event is numbered and is associated with a 
unique New Event bit. The values in the “Event”  and “New Event Bit” columns are determined 
when the Event Logger is configured.  
 
The “Address” column is the PLC address of the bit monitored in the host PLC program for the 
associated event number. This is for information purposes only. It is not automatically entered 
but is entered by clicking on the text box and entering any information of 10 characters or less. It 
can be edited at any time. 
 
The “Description” column, as the name implies, is a description of the event. This also is for 
information purposes only. It is not automatically entered but is entered by clicking on the text 
box and entering any information of 50 characters or less. It can be edited at any time. 
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Searching for Event Information 
Specific event description text or a specific address can be searched by clicking the “Search” 
pull-down menu and then clicking “Find” or by right clicking the mouse and selecting “Find”.  
 

 
 
The “Criteria” box is either the text that is searched for in the “Description” column if the 
“Description” box is selected or the address that is searched for in the “Address” column if the 
“Address” box is selected. Once an event number is located that matches the search criteria other 
occurrences can be located using “Next” and “Previous” options on the “Search” pull-down 
menu. 
 
Printing Event Descriptions 
The Event Descriptions table can be printed or previewed by clicking the “File” pull-down menu 
and then clicking “Print” or “Print Preview”. 
 
Importing and Exporting Event Descriptions 
Event descriptions can be exported and imported by clicking “File” pull-down menu and then 
clicking “Export” or “Import”. When the event descriptions are exported, all 4 columns of data 
are written to a tab delimited text file. When the event descriptions are imported, a tab delimited 
text file is read. This file must meet the following conditions: 
 
• Event number between 1-2500 
• Event description length of 50 characters or less 
• Address length of 40 characters or less 
 
The export and import features are useful for defining large blocks of event descriptions using 
Microsoft Excel or Notepad. 
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EVENT PARAMETERS 
 
Events are displayed for a selected time period. All the events for that period are displayed or 
optionally, only selected events. These parameters for the events display are specified in the 
Parameters window, shown below. This window is accessed from the Event Viewer window by 
clicking the “Display” pull-down menu and then clicking “Event Parameters” or by right-
clicking the mouse and selecting “Event Parameters”. 

 

 
 

When the ACCEPT button is clicked, the Event Viewer window is displayed with the events 
meeting the selected parameter criteria. 
 
Selecting the Time Period 
The start and stop times and dates for the events to be displayed are entered at the top part of the 
sub-window. The dates can be entered or they can be selected from a calendar by clicking on the 
ellipsis next to the date. The time is entered in a 1-12 hour format with “AM” or “PM” . Clicking 
“AM” will change the display to “PM” and visa versa. The start date and time must precede the 
stop date and time. If not, a message will be displayed and the date and times cannot be accepted. 

 
Selecting the Events to be Displayed 
All events within the time period are displayed by clicking the “All” box so that an “x” is 
displayed. The “x” can be removed by clicking on it. If the “All” box doesn’t have an “x” in it, 



 

 
 
 
 

Event Viewer 

 

 
 
Brigger & Associates, Inc. 12 ControlLogix™ Version – Rev 1 

then only specific events are displayed. These events are specified either by entering the event 
numbers in the “Event” column or by specifying an “Event Group”. Event groups are described 
in the “Event Groups” section, below. 
 
Up to 10 events can be specified by entering the event numbers for these events in the “Event” 
column. When the event number is entered, the event description is displayed in the 
“Description” column. The “State” column indicates which status of the event is to be displayed 
is to be displayed: “ON/OFF”, “ON” only, or “OFF” only. Clicking on the status will toggle the 
selection. 
 
Specific events can also be displayed using event groups (see below). An event group is selected 
from the drop-down menu titled “Use Event Group”. 
 
Specifying Event Colors 
Events can be displayed in various colors. If specific events are to be displayed, the color is 
specified by clicking on the event description. This will display a color palette for selecting a 
background color and a foreground color.  
 

 
 
If all events are to be displayed or an event group is to be displayed, the event colors are defined 
by a color definition (see below). 
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EVENT GROUPS 
 
An Event Group is a predefined set of events. When an event group is selected then only those 
events in the Event Group are displayed. Up to 10 Event Groups can be defined. Once defined 
they can be edited. 
 
An event group is defined or edited by clicking the “Setup” pull-down menu, from the Event 
Viewer window, clicking “Event Groups”, and then clicking the name of the event group. These 
groups are by default named “Group 0” through “Group 9”, but the group name can be changed. 
 

 
 
Once an Event Group is selected, the Event Group sub-window is displayed. This window is 
similar to the Event Descriptions window with the addition of “Assign” and “State” columns. 
The “Assign” column is used to select the events to be assigned to the Event Group and the 
“State” column is used to indicate what states to display: On only, Off only, or both On and Off. 
 

 
 
The Event Group name is edited by entering a new name in the “Group Name” text box.  
 
Assigning Events 
Initially, each Event Group has no events assigned. An event is assigned to the group by clicking 
on the box in the “Assign” column so that a check appears. An assigned event can be unassigned 
by clicking the check in the “Assign” column, clearing the check.  
 
Multiple events can be selected to form a set of events all of which are assigned to the group or 
unassigned by clicking “Select to Assign” or “Select to Unassign”, respectively, from the “Edit” 
menu at the top of the window or from the “Edit” menu displayed by right-clicking the mouse. 
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This set can be contiguous rows or non-contiguous rows. Contiguous rows are selected by 
clicking on the first row of the set and holding down the SHIFT key and clicking on the last row 
of the set. Non-contiguous rows are selected by holding down the CTRL key and clicking on the 
individual rows. 
 

 
 
Specifying Event State 
Assigned events can be further specified to only be displayed for certain event states. This is 
selected by clicking the “State” column. The selectable states are: 
 
“ON/OFF” (event goes from on-to-off or off-to-on) 
“ON” (event goes from on-to-off) 
“OFF” (event goes from off-to-on). 
 
As with the group selection, multiple events can be selected to form a set of events all of which 
have the same “State” criteria by clicking the state from the “Edit” menu at the top of the 
window or from the “Edit” menu displayed by right clicking the mouse. This set can also be 
contiguous rows or non-contiguous rows and are selected as described above.  
 
Note that if an event is unassigned its “State” is automatically set to “ON/OFF”. If the “State” is 
changed the event is automatically assigned to the group. 
 
Controlling the Display 
The event group display can display 1) all events; 2) only those assigned to the group; or, 3) only 
those not assigned to the group. This is set by clicking “View” on the pull-down menu at the top 
of the window and then clicking “Full List”, “Only Assigned”, or “Only Unassigned”, 
respectively. It can also be set by right clicking the mouse and selecting “View”. 
 
Searching 
A search for a specific event or specific text within an event description can be performed by 
clicking the “Search” pull-down menu at the top of the window and then clicking “Find” or by 
right-clicking the mouse and clicking “Search” and “Find”. Clicking “Find” displays the Find 
sub-window. This sub-window is the same as that described on page 9. 
 
Selecting an Event Group 
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An Event Group is selected from the Parameters screen using the “Use Event Group” pull-down 
menu: 
 

 
 
When an Event Group is selected, only the events assigned to that group are displayed. Note that 
only one Event Group can be displayed at a time. 
 
 



 

 
 
 
 

Event Viewer 

 

 
 
Brigger & Associates, Inc. 16 ControlLogix™ Version – Rev 1 

COLOR DEFINITIONS 
 
A color definition is a set of events with defined colors. When a color definition is selected then 
those events associated with the color definition are displayed in the colors specified in the 
definition. 
 
A color definition is defined or edited by clicking the “Setup” pull-down menu, from the Event 
Viewer window, clicking “Color Definition”, and then clicking the name of the color definition. 
These are by default named “Color 0” through “Color 9”, but the name can be changed. 
 

 
 
Once a Color Definition is selected, the Color Definition sub-window is displayed. This window 
is similar to the Event Descriptions window with the addition of “Assign”, “On State”, and “Off 
State” columns.  
 

 
 
The Color Definition name is edited by entering a new name is the “Definition Name” text box. 
 
Assigning Events 
Initially, each Color Definition has no events assigned. An event is assigned to the group by 
clicking on the box in the “Assign” column so that a check appears. An assigned event can be 
unassigned by clicking the check in the “Assign” column, clearing the check. As with the Event 
Groups, multiple events can be selected to form a set of events all of which are assigned to the 
definition or unassigned. 
 
Specifying Color of Event State 
Colors are assigned to both the “On” state of the event and the “Off” state. The “On State” 
column is used to select the colors to be assigned when the event state is “On” and the “Off 
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State” column is used to select the colors to be assigned when the event state is “Off”. Clicking 
one of these columns causes a color palette to be displayed for selecting both foreground and 
background colors. 
 

 
 
Controlling the Display 
As with the Event Groups, each color definition window can display 1) all events; 2) only those 
assigned to the definition; or, 3) only those not assigned to the definition. This is set by clicking 
“Full List”, “Only Assigned”, or “Only Unassigned”, respectively on the “View” pull-down 
menu at the top of the window or from the “View” menu displayed by right-clicking the mouse, 
 
Searching 
A search for a specific event or specific text within an event description can be performed by 
clicking the “Search” pull-down menu at the top of the window and then clicking “Find” or by 
right-clicking the mouse and clicking “Search” and “Find”. Clicking “Find” displays the Find 
sub-window, as described above for Event Groups. 
 
Selecting Color Definitions 
A Color Definition is selected from the Parameters screen using the “Apply Color Definitions” 
button: 
 

 
 
Clicking on this button displays a list of the Color Definitions and a check box next to each. 
Clicking on box will select and deselect the associated definition.  Note that multiple color 
definitions can be selected. The number selected is displayed in the button. 
 



 

 
 
 
 

Event Viewer 

 

 
 
Brigger & Associates, Inc. 18 ControlLogix™ Version – Rev 1 

TOTALS 
 
The number of occurrences of events, event totals, are calculated and displayed by the “Totals” 
feature.  These are displayed on a special Event Viewer window: 
 

 
 
The totals are determined for those events that meet the search criteria specified on the 
Parameters window, described below. The following is displayed for each event: 
 
Count 
This is the number of occurrences of the event during the specified time period. 
 
Event Number 
This is the assigned event number for the event. Each event is assigned an event number when 
the event was first configured in the PLC (see Event Collector manual).  
 
Description 
This is an assigned description of the event. Event descriptions are described in the “Event 
Descriptions” section. 
 
Address 
This is the assigned address of the monitored digital condition. These are entered when the event 
descriptions are entered.  
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TOTALS PARAMETERS 
 
The number of event occurrences are calculated for a selected time period. As with the display of 
events, this can be for all of the events for that period or, optionally, only selected events. These 
parameters are specified in the Parameters window, shown below. This window is accessed 
from the Event Viewer window by clicking the “Display” pull-down menu and then clicking 
“Total Parameters” or by right-clicking the mouse and selecting “Total Parameters”. 
 

 
 
When the ACCEPT button is clicked, the Event Viewer totals window is displayed with the 
events meeting the selected parameter criteria. 
 
Selecting the Time Period 
The start and stop times and dates for the events to be displayed are entered at the top part of the 
sub-window. The dates can be entered or they can be selected from a calendar by clicking on the 
ellipsis next to the date. The time is entered in a 1-12 hour format with “AM” or “PM” . Clicking 
“AM” will change the display to “PM” and vice versa. The start date and time must precede the 
stop date and time. If not, a message will be displayed and the date and times cannot be accepted. 

 
Selecting the Events to be Displayed 
All events within the time period are counted by clicking the “All” box so that an “x” is 
displayed. The “x” can be removed by clicking on it. If the “All” box doesn’t have an “x” in it, 
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then only specific events are counted. These events are specified either by entering the event 
numbers in the “Event” column or by specifying a “Total Group”. Total groups are described in 
the “Total Groups” section, below. 
 
Up to 10 events can be specified by entering the event numbers for these events in the “Event” 
column. When the event number is entered, the event description is displayed in the 
“Description” column.  
 
Specific events can also be displayed using total groups (see below). An total group is selected 
from the drop-down menu titled “Use Total Group”. 
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TOTAL GROUPS 
 
A Total Group, like an Event Group, is a predefined set of events. When a total group is selected 
then only those events in the group are counted. Up to 5 Total Groups can be defined. Once 
defined they can be edited. 
 
An total group is defined or edited by clicking the “Setup” pull-down menu, from the Event 
Viewer window, clicking “Total Groups”, and then clicking the name of the event group. These 
groups are by default named “Group 0” through “Group 4”, but the group name can be changed. 
 
Once an Total Group is selected, the Total Group sub-window is displayed. This window is 
similar to the Event Description window with the addition of an  “Assign” column. The “Assign” 
column is used to select the events to be assigned to the Total Group.  
 

 
 
The Total Group name is edited by entering a new name in the “Group Name” text box.  
 
Assigning Events 
Initially, each Total Group has no events assigned. An event is assigned to the group by clicking 
on the box in the “Assign” column so that a check appears. An assigned event can be unassigned 
by clicking the check in the “Assign” column, clearing the check.  
 
Multiple events can be selected to form a set of events all of which are assigned to the group or 
unassigned by clicking “Select to Assign” or “Select to Unassign”, respectively, from the “Edit” 
menu at the top of the window or from the “Edit” menu displayed by right clicking the mouse. 
This set can be contiguous rows or non-contiguous rows. Contiguous rows are selected by 
clicking on the first row of the set and holding down the SHIFT key and clicking on the last row 
of the set. Non-contiguous rows are selected by holding down the CTRL key and clicking on the 
individual rows. 
 
Controlling the Display 
The total group display can display 1) all events; 2) only those assigned to the group; or, 3) only 
those not assigned to the group. This is set by clicking “View” on the pull-down menu at the top 
of the window and then clicking “Full List”, “Only Assigned”, or “Only Unassigned”, 
respectively. It can also be set by right clicking the mouse and selecting “View”. 
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Searching 
A search for a specific event or specific text within an event description can be performed by 
clicking the “Search” pull-down menu at the top of the window and then clicking “Find” or by 
right-clicking the mouse and clicking “Search” and “Find”. Clicking “Find” displays the Find 
sub-window. This is the same as that described on page 9. 
 
Selecting an Total Group 
An Total Group is selected from the Parameters screen using the “Use Event Group” pull-down 
menu: 
 

 
 
When an Total Group is selected, only the events assigned to that group are counted. Note that 
only one Total Group can be selected at a time. 
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PRINTING 

 
The displayed events are printed by selecting “Print” from the “File” drop down menu. All of the 
events can be printed or a single page or range of pages. The printout of the events can be 
displayed by clicking “Print Preview” from the “File” drop down menu in order to determine 
which pages to print. 
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